
Škoda Scala už

od 17 130 €

Jesenné cenové zvýhodnenie

až 2 300 €

Cenník Škoda Scala



Zvýhodnenie* -2 300 -2 300 -2 300
Akciová cena ** 17 130 18 780 22 930

Zvýhodnenie* -2 300 -2 300 -2 300
Akciová cena ** 18 280 19 870 24 010

Zvýhodnenie* -2 300 -2 300 -2 300
Akciová cena ** 20 240 21 960 26 110

Zvýhodnenie* - -2 300 -2 300
Akciová cena ** - 21 370 25 530

Zvýhodnenie* - -2 300 -2 300
Akciová cena ** - 23 480 27 640

Všetky informácie o aute
Modelová stránka

Vyskladajte si auto podľa seba
Online konfigurátor

* Jesenné cenové zvýhodnenie je platné do 31.1.2026. Bližšie informácie o uplatnení a podmienkach akcie získate u participujúcich dílerov Škoda.
** Najnižšie ceny príslušných motorových vozidiel za posledných 30 dní vám poskytujeme v zmysle zákona č. 108/2024 Z.z. o ochrane spotrebiteľa
a sú dostupné na internetovej stránke www.skoda.sk/ceny.

Scala
Motor

.
Palivo

.
Prevodovka

.
Pohon

.
Cena (s DPH)

.
Essence

.
Selection

.
Monte Carlo

.

1.0 TSI 70kW (95k)
.

Benzín
.

5° MP
.

predný
. Základná cena . 19 430 . 21 080 . 25 230 .

1.0 TSI 85kW (116k)
.

Benzín
.

6° MP
.

predný
. Základná cena . 20 580 . 22 170 . 26 310 .

1.0 TSI 85kW (116k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . 22 540 . 24 260 . 28 410 .

1.5 TSI 110kW (150k)
.

Benzín
.

6° MP
.

predný
. Základná cena . - . 23 670 . 27 830 .

1.5 TSI 110kW (150k)
.

Benzín
.

7° AP DSG
.

predný
. Základná cena . - . 25 780 . 29 940 .
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Prečo práve Scala?

Kompaktná zvonku
Kompaktné rozmery vozidla prídu vhod pri každodennom
dochádzaní do práce a zariaďovaní ďalších povinností. Ľahko
zaparkujete aj v obmedzenom priestore a pri tom môžu pomôcť
predné aj zadné parkovacie senzory alebo zadná parkovacia kamera.

Veľká zvnútra
Priestranný interiér vyhovie nárokom celej rodiny a batožinový
priestor s objemom 467 litrov pojme prekvapivo mnoho vecí. Chytré
detaily v podobe háčikov na tašky, sieťového programu a ďalších
vylepšení si nebudete môcť vynachváliť.

Špičková výbava
Full LED Matrix predné svetlomety, elektricky odistiteľné a sklopné
ťažné zariadenie alebo vyhrievané čelné sklo sú len výberom zo
špičkových prvkov výbavy, ktoré si môžete vo svojej Scale dopriať.

Športová verzia
Pre motoristických fajnšmekrov máme pripravenú športovú verziu
Monte Carlo. Dizajnové detaily v lesklej čiernej farbe a špecifické
kolesá spestrujú vonkajší dizajn vozidla, zatiaľ čo vnútri sa budete cítiť
ako v športovom vozidle vďaka športovým predným sedadlám,
športovému trojramennému volantu, krytom pedálov z ušľachtilej
ocele a čiernemu stropu s panoramatickou strechou.

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Interiér Studio

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

ESC vrátane ABS, EBV, MSR, ASR, EDS, HBA, DSR, ESBS, XDS+,
TPM, multikolíznej brzdy (MKB) a funkcie Prefill

Front Assist - výstraha pred kolíziou a podpora núdzového brzdenia
a Pederstrian Monitor (ochrana chodcov)

Easy Light Assist – svetelný senzor

Lane Assist – asistent udržiavania v jazdnom pruhu

ISOFIX na sedadle spolujazdca

3. hlavová opierka vzadu

Centrálne zamykanie s diaľkovým ovládaním, 2 sklopné kľúče

Full LED predné svetlomety

Oceľové disky kolies 6J × 16" s krytmi Tecton

Brzdy kotúčové (predné aj zadné)

Virtuálny kokpit 8"

Čítanie dopravných značiek

2-ramenný PUR volant

Obmedzovač rýchlosti

Infotainment Škoda s 8" displejom a 2x USB-C vpredu

eCall, CareConnect na 3 roky

Bluetooth

Manuálna klimatizácia s peľovým filtrom

Výškovo nastaviteľné sedadlo vodiča

Zadné parkovacie senzory

Driver Alert - asistent rozpoznania únavy

Elektricky ovládané a vyhrievané vonkajšie spätné zrkadlá

Vonkajšie spätné zrkadlá a kľučky dverí lakované vo farbe karosérie

Elektrické ovládanie okien vpredu

Asistent rozjazdu do kopca (iba pre AP)

Paket Simply Clever: háčiky na tašky – pevné, nesklopné, odkladacia
schránka – na strane za podbehom, uchytávacie klipy pre sieťový
program, sieťový program, 12V zásuvka v batožinovom priestore

Sada na opravu pneumatík

Predĺžená záruka na 5 rokov/100 000 km
(Platí tá z podmienok, ktorá nastane skôr, prvé 2 roky bez obmedzenia
počtu kilometrov)

Premenlivý servisný interval s výmenou oleja až 30 000 km alebo
každé 2 roky

Škoda – Doživotná Garancia Mobility Premium
Poskytuje pomoc servisným vozidlom na mieste poruchy (porucha
na vozidle, chýbajúce PHM, defekt pneumatiky, zabuchnuté/stratené
kľúče, vybitá batéria, zámena paliva), odtiahnutie vozidla, prípadne
služby – náhradnú dopravu, požičanie náhradného vozidla, ubytovanie
pre posádku a i.

Interiér Loft

Asistent rozjazdu do kopca

Disky Nyota z ľahkej zliatiny 6J × 16" – strieborné

Predné hmlové svetlá

2-ramenný multifunkčný kožený volant (pre AP s podvolantovým
ovládaním DSG)

Easy Start – bezkľúčové štartovanie

Tempomat

Lakťová opierka s JumboBox

2× USB vzadu (typ C len na nabíjanie)

Bezdrôtový Smartlink

Ďalšie 4 reproduktory vzadu

Vnútorné spätné zrkadlo s automatickým stmavovaním

Elektrické ovládanie okien vzadu

Climatronic – dvojzónová automatická klimatizácia so senzorom
vlhkosti a kombi filtrom

Vyhrievanie predných sedadiel

Výškovo nastaviteľné sedadlo vodiča a spolujazdca

Ukazovateľ stavu kvapaliny v ostrekovači

Dáždnik

Interiér Monte Carlo

Dažďový senzor

KESSY - bezkľúčové odomykanie, zamykanie a štartovanie

Full LED Matrix predné sveltomety

Predné hmlové svetlá s corner funkciou

Full LED zadné svetlá s dynamickým ukazovateľom smeru

Predĺžené sklo 5 dverí a panoramatická strecha

Čierny strop

Disky Kajam Aero z ľahkej zliatiny 6,5J × 17" – čierne

Ambietné osvetlenie prepínateľné biela/červená

Kryty pedálov z ušľachtilej ocele

10" virtuálny kokpit

3-ramenný vyhrievaný multifunkčný kožený volant (pre AP
s podvolantovým ovládaním DSG)

Zadná lakťová opierka

Predné a zadné parkovacie senzory

Driving Mode Select, Zadná parkovacia kamera

Sunset

Elektricky sklopné, ovládané a vyhrievané vonkajšie spätné zrkadlá
v čiernej farbe

Vkladané tkané koberce vpredu a vzadu

Čierne dizajnové prvky (predný a zadný nárazník)

Základná výbava

Essence

Selection (navyše oproti Essence)

Monte Carlo (navyše oproti Selection)
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Doplnková výbava

Essence Plus › Elektricky ovládané zadné okná
› Výškovo nastaviteľné sedadlo spolujazdca
› Predné hmlové svetlá
› Tempomat
› Vkladané tkané koberce vpredu a vzadu

WIL 549

Light & View › Dažďový senzor
› Full LED zadné svetlá s dynamickým ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky sklopné vonkajšie spätné zrkadlá s automatickým

stmievaním na strane vodiča
› Vnútorné spätné zrkadlo s automatickým stmavovaním (iba

pre Essence)
› Elektrické ovládanie okien vzadu (iba pre Essence)

(WYH platí len pre Selection iba v kombinácii s WIS/WI2/PMA)
(WYH nie je možné s PYB)

WIH/WYH 860 480 •

Light & View Plus › Naviac oproti Light & View
› Full LED Matrix predné svetlomety

(WYI platí iba v kombinácii s WIS/WI2/PMA)

WII/WYI − 1291 •

Adaptive Cruise Control - adaptívny tempomat do 210km/h PC5 − 490 490

Assisted Drive › Adaptive Cruise Control - adaptívny tempomat do 210km/h
› Adaptive Lane Assist

PIA − 668 668

Assisted Drive Plus › Naviac oproti Assisted Drive
› Side Assist
› Dažďový senzor
› Full LED zadné svetlá s dynamickým ukazovateľom smeru
› Predné hmlové svetlá s corner funkciou
› Elektricky sklopné vonkajšie spätné zrkadlá

(PYB platí pre Selection iba v kombinácii s WIS/WI2/PMA)

PIB/PYB − 1343 863

Safety › Crew Protect Assist – proaktívna ochrana cestujúcich
› Kolenný airbag vodiča
› Bočné airbagy vzadu

WIX − 544 544

Deliaca sieťová stena 3CX 125 125 125

Medzipodlaha batožinového priestoru 3GD 181 181 181

Simply Clever Plus › Sieťový program
› Odkladací priestor pod prednými sedadlami
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Držiak na tablet a telefón

(nie je možné s PWA/WQ7)

PIK 280 280 280

Simply Clever Plus
(pre elektricky ovládané
sedadlo vodiča)

› Sieťový program
› Ochrana hrán bočných dverí
› Obojstranný koberec v batožinovom priestore
› Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Držiak na tablet a telefón

(možné len s PWA/WQ7)

PI2 − 242 242

Príprava na ťažné zariadenie 1D7 216 216 216

Ťažné zariadenie – sklopné 1M6 1017 1017 1017

Adaptér pre ťažné zariadenie ND1 40 40 40

Ostrekovače svetlometov 8X1 156 156 156

Essence Selection Monte CarloAkčné pakety

Essence Selection Monte CarloBezpečnosť

Essence Selection Monte CarloFunkčnosť
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Interiér Lodge › Láťkové sedadlá Lodge
› Ambientné osvetlenie červené /biele
› Sivý poťah prístrojovej dosky
› Medené orámovanie výduchov ventilácie
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu

(iba s interiérom HP/HQ)

WQ3 − 449 −

Interiér Dynamic › Športové sedadlá
› Čierny strop
› 3-ramenný kožený športový multifunkčný volant (pre AP

s podovlantovým ovládaním DSG)
› Ambientné osvetlenie červené /biele
› Čierny poťah prístrojovej dosky
› Červené orámovanie výduchov ventilácie
› Kryty pedálov z ušľachtilej ocele
› Zadná ľakťová opierka
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Scala

(iba s interiérom AH)

WQ4 − 998 −

Interiér Suite › Poťah sedadiel Suedia /koža /umelá koža
› Čierny poťah prístrojovej dosky
› Chrómové orámovanie výduchov ventilácie
› Zadná ľakťová opierka
› Elektricky nastaviteľné sedadlo vodiča
› Ambientné osvetlenie červené /biele
› Vkladané tkané koberce vpredu a vzadu
› Prahové lišty s názvom Scala

(iba s interiérom JG/JI)

WQ7 − 1641 −

Elektricky nastaviteľné sedadlo vodiča (možné len s WQ3/WQ4, nie je možné s PIK) PWA − 501 501

2-ramenný kožený multifunkčný volant (možné len s WIL) PLC 376 • −

2-ramenný kožený vyhrievaný multifunkčný volant PLE − 109 −

3-ramenný kožený vyhrievaný športový multifunkčný volant PLM − 248 −

2-ramenný kožený vyhrievaný multifunkčný volant pre DSG PLG − 109 −

3-ramenný kožený vyhrievaný športový multifunkčný volant pre DSG PLP − 248 −

3-ramenný kožený športový multifunkčný volant PLK − 137 −

3-ramenný kožený športový multifunkčný volant pre DSG PLN − 137 −

Disky z ľahkej zliatiny Cortadero Aero 6J x 16" (205/55) P02 638 0 −

Disky z ľahkej zliatiny Nyota 6J x 16" (205/55) P06 720 • −

Disky z ľahkej zliatiny Montado Aero 6J x 16" – čierne (205/55) P08 864 144 −

Disky z ľahkej zliatiny Kajam 6,5J x 17" (205/50) PJG − 604 −

Disky z ľahkej zliatiny Stratos 6,5J x 17" (205/50) PJP − 564 −

Disky z ľahkej zliatiny Propus Aero 6,5J x 17" – čierne (205/50) PJR − 708 −

Disky z ľahkej zliatiny Ursa Aero 7J x 18" – čierne (205/45) P20 − 1230 −

Disky z ľahkej zliatiny Fornax 7J x 18" – strieborné (205/45) PJN − 1189 −

Disky z ľahkej zliatiny Vega Aero 7J x 18" – čierne (205/45) PJV − 1333 −

Disky z ľahkej zliatiny Ursa 7J x 18" – čierne (205/45) PJI − − 585

Rezerva na oceľovom disku (neplnohodnotná), zdvihák, kľúč na kolesá PJA 170 170 170

Essence Selection Monte CarloVolanty / interiéry / sedadlá

Essence Selection Monte CarloDisky / pneumatiky
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Winter › Vyhrievané predné sedadlá
› Ukazovateľ stavu kvapaliny v ostrekovači

WIC 240 • −

Winter Premium › Vyhrievané čelné sklo
(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)

WIE − 151 151

Winter Premium &
Technology Plus

› Vyhrievané čelné sklo
› Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(možné len s PLG/PLP/PLE/PLM)
(nie je možné s 4A4)
(WI3 platí pre Monte Carlo)

PMA/WI3 − 354 354

Paket pre zlé cesty (zvýšený podvozok o 15 mm, dodatočná ochrana podvozka) PZP 156 156 −

Vyhrievané zadné sedadlá (nie je možné s WIE/PMA/WI3) 4A4 − 193 193

Drive › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie a štartovanie
› Čierne lakované spätné zrkadlá a predná maska
› 10" Virtuálny kokpit (iba pre Selection)
› Sunset
› Sport Chassis Control–podvozok s nastaviteľnou tuhosťou tlmičov
› Drive Mode Select

(možné len s P08/PJV/PJR)

PKS − 1251 311

Drive so Safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie a štartovanie
› Alarm
› Čierne lakované spätné zrkadlá a predná maska
› 10" Virtuálny kokpit (iba pre Selection)
› Sunset
› Sport Chassis Control–podvozok s nastaviteľnou tuhosťou tlmičov
› Drive Mode Select

(možné len s P08/PJV/PJR)

PKW − 1509 515

Sunset 4KF − 176 •

Chrome paket › Sunset
› Podokenná chromová lišta

PIF − 320 −

Image paket › Predĺžené sklo piatych dverí
› Spojler
› Sunset

PIU − 354 •

Emotion paket › Naviac oproti Image:
› Panoramatická strecha
› Čierny strop
› Bez schránky na okuliare)

(možné len s interiérmi HO/HQ/JI/AH)

WIV − 1216 •

Predné parkovacie senzory 7X2 − 371 •

Zadná parkovacia kamera KA2 − 411 •

Convenience so safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie a štartovanie
› Drive Mode Select
› Predné parkovacie senzory
› Alarm

WJM − 1013 254

Convenience Plus so safe › Naviac oproti Convenience so safe
› Elektricky ovládané piate dvere s virtuálnym pedálom
› 10" Virtuálny kokpit

WJN − 1697 615

Convenience Premium so
safe

› Naviac oproti Convenience Plus so safe
› Parkovací asistent

WJO − 1823 813

Convenience bez safe › Zadná parkovacia kamera
› Kessy - bezkľúčové odomykanie, zamykanie a štartovanie
› Drive Mode Select
› Predné parkovacie senzory

WIM − 771 •

Convenience Plus bez safe › Naviac oproti Convenience bez safe
› Elektricky ovládané piate dvere s virtuálnym pedálom
› 10" Virtuálny kokpit

WIN − 1453 412

Convenience Premium bez
safe

› Naviac oproti Convenience Plus bez safe
› Parkovací asistent

WIO − 1578 612

Essence Selection Monte CarloKomfort
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Technology › 4 reproduktory vzadu
› Bezdrôtový Smartlink
› Lakťová opierka s JumboBox
› 2x USB -C vzadu

WIQ 581 • −

Technology Plus › Phonebox bez LTE
› USB-C vo vnútornom spätnom zrkadle

(WI2 iba v kombinácii s PLG/PLP/PLE/PLM)

WIS/WI2 − 203 293

Navi paket › 9.2" Škoda Navigation
› 10" Virtuálny kokpit
› Web Rádio
› Hlasové ovládanie
› Infotainment Online na 3 roky

WIT − 1285 894

Sound paket › Sound System Škoda,
› Rezervné koleso (dojazdové)
› Zdvihák + klúč na kolesá

(pre Selection možné len s WQ3/WQ4/WQ7 a naviac v kombinácii
s 10" Virtuálnym kokpitom možné len s WIT)
(pre Monte Carlo iba s WIT)

PJC − 710 710

Alarm PD1/PD3 278 278 −

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Black paket › Čierno-lakované spätné zrkadlá
› Čierna predná maska chladiča
› Sunset

(iba s P08/PJV/PJR a zároveň PIU/WIV)

PMY − 198 •

Modrá Energy UNI 0 0 0

Biela Candy SPE 406 406 406

Sivá Steel, Metalické farby MET 585 585 585

Červená Velvet FLT 1033 1033 1033

Predĺžená záruka na 5 rokov/100 000km EA4 0 0 0

Predĺžená záruka na 5 rokov/150 000km EA9 205 205 205

Servis 5 rokov/75 000 km 818 1556

Servis 5 rokov/100 000 km 1046 2178

Servis 5 rokov/150 000 km 1526 3438

Essence Selection Monte CarloMultimédiá

Essence Selection Monte CarloZabezpečenie vozidla

Essence Selection Monte CarloOstatné

Basic ProfessionalServisné balíčky
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Ponuka farieb a diskov

Červená Velvet, metalická Čierna Magic, metalická Modrá Race, metalická

Biela Moon, metalická Strieborná Smokey Diamond, metalická Sivá Graphite, metalická

Modrá Energy, uni Sivá Steel, uni Biela Candy, uni

Ursa 18"
čierne

Vega Aero 18"
čierne

s aero krytmi

Fornax 18"
strieborné

Ursa Aero 18"
strieborné

s aero krytmi

Kajam 17"
čierne

s aero krytmi

Propus Aero 17"
čierne

Stratos 17"
strieborné

Kajam 17"
strieborné

s aero krytmi

Montado Aero 16"
čierne

Nyota 16"
strieborné

Cortadero Aero 16"
strieborné

Oceľové disky 16"
s krytmi Tecton
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Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH 23%.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 20.10.2025 (MR2026)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda
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